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Chapter 1 — Exploring the Network

1.0.1.2 Class Activity — Draw Your Concept of the Internet

Objectives

Networks are made of many different components

In this activity, you will visualize how you are connected, through the Internet, to those places, people, or
businesses with whom (or which) you interact on a daily basis. After reflection and sketching your home’s or
school’s topology, you can draw conclusions about the Internet that you may not have thought of prior to this
activity.

Background / Scenario

Draw and label a map of the Internet as you interpret it now. Include your home or school/university location
and its respective cabling, equipment, devices, etc. Some items you may want to include:

e Devices or equipment

e Media (cabling)

e Link addresses or names

e Sources and destinations

¢ Internet service providers
Upon completion, save your work in a hard-copy format, it will be used for future reference at the end of this

chapter. Ifit is an electronic document, save it to a server location provided by your instructor. Be prepared to
share and explain your work in class.

For an example to get you started, please visit: http://www.kk.org/internet-mapping

Required Resources

e Internet access

e Paper and pencils or pens (if students are creating a hard copy)

Reflection

After reviewing your classmates drawings, were there computer devices that you could have included on your
diagram? If so, which ones and why?

After reviewing your classmates’ drawings, how were some of the model designs the same or different?
What modifications would you make to your drawing after reviewing the other drawings?

In what way could icons on a network drawing provide a streamlined thought process and facilitate your learn-
ing? Explain your answer.
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1.1.1.8 Lab — Researching Network Collaboration Tools

Objectives

Part 1: Use Collaboration Tools

e |dentify current awareness of collaboration tools.

e Identify key reasons for using collaboration tools.

Part 2: Share Documents with Google Drive
Part 3: Explore Conferencing and Web Meetings

Part 4: Create Wiki Pages

Background / Scenario
Network collaboration tools give people the opportunity to work together efficiently and productively without
the constraints of location or time zone. Collaborative tool types include document sharing, web meetings,
and wikis.
In Part 1, you will identify collaboration tools that you currently use. You will also research some popular col-

laborative tools used today. In Part 2, you will work with Google Drive. In Part 3, you will investigate Confer-
encing and Web meeting tools and, in Part 4, you will work with wikis.

Required Resources

Device with Internet access

Part 1: Use Collaboration Tools

Step 1: List some collaboration tools that you currently use today.

Step 2: List some reasons for using collaboration tools.
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Part 2: Share Documents with Google Drive

In Part 2, you will explore the document sharing functions by using Google Drive to set up document sharing.
Google Drive, formally Google Docs, is a web-based office suite and data storage service that allows users
to create and edit documents online while collaborating in real-time with other users. Google Drive provides 5
GB of storage with every free Google account. You can purchase additional storage, if needed.

Step 1: Create a Google account.

To use any of Google’s services, you must first create a Google account. This account can be used with any
of Google’s services, including Gmail.

a. Browse to www.google.com and click Sign in (located at the top-right corner of the web page).

+You Search Images Maps Play YouTube News Gmail Documents Calendar More -

Google Search I'm Feeling Lucky

Advertising Programs ~ Business Solutions  Privacy & Terms  +Google  About Google

b. On the Google Accounts web page, if you already have a Google account, you can sign in now; other-
wise, click SIGN UP.

Google

Accounts
Sign in Google
Google has more to offer when you sign in to your Google Account. 9 oRS
Sign in on the right or create an account for free. Enell
M Gmail
Chat with fiends and never miss an important email. Password

@) Search, plus Your World
- Search the web plus your photos, posts, and stuff friends have
plus youre P [V Stay signed in

shared with you.

Can't access your account?

Like Google?

Make Google your homepage

P

See more benefits of a Google Account.

c. On the Create a new Google Account web page, fill out the form to the right. The name you enter in the
Choose your username field becomes the account name. It is not necessary to supply your mobile
phone or current email address. You must agree to the Google Terms of Service and Privacy Policy be-
fore clicking Next step.
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GO‘\ )gle S

Create a new Google Account

o : Your Google Account is
» more than just Search. Uiz
.ii Talk, chat, share, schedule, store, organize | First | ‘ Last |
-‘ collaborate, discover, and create. Use You can't leave this empty.
. Google products from Gmail to Google+ to
- E‘ YouTube, view your search history, all with Choose your username
- ) one username and password, all backed up | ~ . |
. ) @gmail.com
"N all the time and easy to find at (you
YI]lI guessed it) Google com You can't leave this empty.
Tuhs Create a password
; - Confirm your password
Take it all with you. LRt
A Google Account lets you access all your
stuff — Gmail, photos, and mare — from ;
I . . Birthday
any device. Search by taking pictures, or by
voice. Get free turn-by-tumn navigation Maonth 5 4 1974
upload your pictures automatically. and
even buy things with your phone using Gender
Google Wallet
lam... =
Share a little. Or share a lot. Mobile phone
Share selectively with fiends, family =-
ur boss) on Google+. Start
avideo hangout with friends, text a group all Your current email address
at once, or just follow posts fram people
who fascinate you. Your call
Prove vou're not a rohot

d. The next web page allows you to add a profile photo if you would like. Click Next Step to complete the
account creation process.

Step 2: Create a new document.

a. Signin to Google using the access credentials you created in Step 1. Type http://drive.google.com in
your browser and press Enter. This navigates you to Google Drive.

Go\-;;gle

Drive
Welcome to Google Drive, the new home for Google Docs Sign in Google
Email
% Access everywhere
Password
» Store files safely
Collaborate with Google ¥ Stay signed in
B, Docs
Can't access your account?
Learn more

b. Click the CREATE button to display a drop-down menu that allows you to select the type of document to
create. Choose Document.
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+John Search Images Maps Play YouTube MNews Gmail Drive Calendar More -
GO)SI@ “ John Smith | 0 || + Share 'fi,: -
Drive sot v | =1 o I
| » My Drive .
Shared with me Welcome to Google Drive! . .
Starred
R are To get started, install Google Drive on your PC. Then, add files to Google ‘ §
Mecem Drive on your PC and theyll automatically sync to My Drive. e
ore + ‘ g
Download Google Drive
Access everywhere Share & collaborate ® @
Access Google Drive everywhere by Share files, folders and Google )
signing into drive_google com or Docs to collaborate with exactly
using the mobile app. J who you want. () _..
[ Y

The new document displays. Many of the functions of the Google editor work similarly to Microsoft Word.

Step 3: Share a Google document.

a. After the blank Google document opens, you can share it with others by clicking the Share button (at the
top-right corner of the web page).

John Smith =
Untitled document ‘ Comments ‘ Share .
File Edit View Inset Format Tools Table Help ———
= e L] - P Normaltext - | Arial ln -lB 7 UA-A-co|iZEEE|EE = (1=~ A
1 1 z 2 4 5 8 7

b. Name your new document, then click the Save button.

Name before sharing

Let collaborators know what this document is about

Untitted document

e -

c. Here on the Sharing settings web page, in the Add people text field, you can enter Google email names,
email addresses, or groups with whom to share this document.
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Sharing settings

Link to share (only accessible by collaborators)

https://docs_google com/document/d/19ZaQ1f5Scnxw7DOFILMEaaF40WHpDOyEXo"

Share link via:

Who has access

Private - Only the people listed below can

Change...
access
5 John Smith (you) jsmith.netacad@gmail.com ls owner
Add people:
Enter names, email addresses, or groups...
gople and change the permissions. [Chan

d. As soon as you start entering information into the Add people box, the box provides more options. The
Can edit drop-down menu allows you to choose the document privileges (Can edit, Can comment, Can
view) for the people you add. You can also specify how to notify these people of this document (Send a
copy to myself or Paste the item itself into the email). Click Share & save.

Add people:  Choose from contacts

John Doe

v MNotify people via email - Add message
Send a copy to myself

Paste the item itself into the

e. Click the Done button. This will navigate you back to the open document.

f.  All users with share privileges can view this document at the same time. Users with edit privileges can
edit this document while others view it.

g. If the document is being viewed by someone while you are in it, you can see who they are by clicking the
other viewer(s) drop-down menu (in the upper-right corner of the document).
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John Smith

¢b1 other viewer e [ |
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} |
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Step 4: Close a Google document.

To close a Google document, move your cursor to the document name at the top of the screen and a left ar-
row will appear to the left of the name. Click that arrow to return to your Google Drive home page. The docu-
ment is automatically saved.

The new document will appear at the top of your documents list under My Drive.

+John Search |Images Maps Play YouTube MNews Gmail Drive Calendar More -
Go fglt‘ “ John Smith | 0 | + -
Drive -t [ | [} ® Maore ~ sot - | = |22 o -

Meet your Drive Then, go for a spin

¥ My Drive My Drive is the home for all your files. ‘ . . * Explore the left hand navigation.

Shared with me With Google Drive for your PC, you « Create Google Docs and more.

can sync files from your computer to
Starred My Drive. # See files at a glance with the new grid view.
Recent e Get the Google Drive mobile app.

More - Download Google Drive for PC

Download Google Drive
My Drive

£l TITLE OWNER LAST MODIFIED

v B Test Document 1 Shared

me 12:00 pm me

Step 5: Additional Information

Google has developed apps for PCs and Smart phones. For more information about Google Drive, go to
http://drive.google.com. YouTube is also a viable source of Google Drive tutorials.

Part 3: Explore Conferencing and Web Meetings

Web meetings combine file and presentation sharing with voice, video, and desktop sharing. Cisco WebEx
Meeting Center is one of the leading web meeting products available today.

In Part 3 of this lab, you will watch a video produced by Cisco that reviews the features contained within
WebEx Meeting Center. The video is located on YouTube at the following link: http://www.youtube.com/
watch?v=fyaWHEF_aWg
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Part 4. Create Wiki Pages

“Wiki” is a Hawaiian-language word that means fast. In networking terms, a wiki is a web-based collabora-
tion tool that permits almost anyone to immediately post information, files, or graphics to a common site for
other users to read and modify. A wiki provides access to a home page that has a search tool to assist you in
locating the articles that interest you. A wiki can be installed for the Internet community or behind a corporate
firewall for employee use. The user not only reads wiki contents, but also participates by creating content
within a web browser.

Although many different wiki servers are available, the following common features have been formalized into
every wiki:
e Any web browser can be used to view or edit pages or create new content.

e Edit and auto links are available to edit a page and automatically link pages. Text formatting is similar to
creating an email.

e Asearch engine is used for quick content location.
e Access control can be set by the topic creator, defining who is permitted to edit content.

e Awikiis a grouping of web pages with different collaboration groups.

In this part of the lab, you will use the Google account that you created in Part 2 and create a wiki page in
Google Sites.

Step 1: Sign in to Google Sites.

Go to http://sites.google.com and sign in using the Google account that you created in Part 2 of this lab.

¥) Google Sites - Free websites and wikis - Mozilla Firefox ] 3
Eile Edit View History Bookmarks Tools Help

| ool Sites - Free websites and ikis |+
(— @ hitps: /faccounts.google. com/ServiceLogin?service =jotspotapassive = 1209600 8continue =https: sites. google. com /&followup=https: /jsites. google.« c ‘ |-.'V Google f—‘| i

= Latest Headlines () Google Docs -Folder .. 44/ CPR User Lookup |_: Metlnsight - Software... Lab Licensing - Licenses 4% Pricing Toal - Cisco.com »

Ylay  YouTube mail More - John Smith . o

Sites|

Sign in Google
Thinking of creating a website? 3 -

Email
Google Sites is a free and easy way to create and share webpages. Leamn more. mai

jsmith_netacad@gmail.com
Create b @g

rich web pages easily
Password

Collect

N . ssssssseeY
all your info in one place

Can't access your account?

Control
who can view and edit

MNew! Create a site from dozens of pre-built templates

Sign out and sign in as a different user

The Google Science Fair
An online science competition for curious young minds across the globe.
All you need is a question. What's yours? b
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Step 2: Click CREATE.

) Google Sites - Mozilla Firefox 10l x|
File Edit View History Bookmarks Tools Help

| [ Google sites [T]

| € @ hiips: /sites.google.com - c

- Googe £l &

|£) Most visited [} Getting Started . Latest Headines _ Google Docs -Folder . #4% CPR User Lookup | | Netinsight - Software . [ Lab Licensing - Licenses 44 Pricing Tool - Cisco.com »

+John Search Images Maps Play YouTube MNews Gmail Drive Calendar More -

GO-_)SIQ Search my sites “ John Smith | 0 + Share }',:___v

Sites -

Thinking of creating a website?
Use Sites to

Google Sites is a free and easy way to create and share webpages. Learn

My mare.
My Sites Plan club mestings and activities

Deleted Sites Share info on a secure company intranet
Collaborate on a team project

Stay connected with family members

Learn more about Google Sites

©2012 Google | Terms | Report an lssue | Help Center

Step 3: Name your new wiki site.

In the Name your site field, type in a name for your new wiki site. You will need to come up with a unique
name for your site that has not been used by any other Google user. Google also requires that you enter the
code (displayed at the bottom of the screen) to prevent automated scripts, called web robots, from creating
multiple sites. After you have entered your site name, click the CREATE button. If someone has used your
site name already, you are prompted to enter another name.
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Drive  Calendar More

GO;)S[C Search my sites “ sonnsmith | o | | + snare > J7l]-

Sites @ cancel -

Select a template to use:

Blank template Classroom site @, Soccer team Q Spring Floral

Wedding
Kame your site:
Wiki Example C1LA

Instructional Q@
Site location - URLs can only use the following characters: A-Z,a-z 0-9

Browse the
gallery for
more

le.comisite! la

» Select a theme

» More options

Type the code shown:

Al

oot 18

. Report an Issue | Help Center Y

Step 4: Edit the look of your new wiki site.

a. Google has provided templates for you to change the look of your new wiki site. Click the More drop-
down menu, and then click Manage site.

Take our survey! ’
—d e —

Page actions
Fewision Histoary

Subscribe to page changes
Fage settings

= Print page

-

Freview page as viewer

Page templates
Sites
Sawe as page template

Change page template

Site actions
Subscribe to site changes

jout Newl

Manage site

Sign up for AdSense

2+ Sharing and Permigsions

Sites help

Report an Issue
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b. Click Themes at the bottom of the left sidebar.

Manage Site

< Wiki Example C1LA

Recent site activity
Pages
Attachments

Page templates
Apps Scripts

Deleted items

General

Sharing and
Permissions

AdSense
Web Address

Site layout

Colors and Fonts

c. Select a theme that appeals to you and click SAVE.

+John Search Im

Google
Manage Site

< Wiki Example C1LA

Recent site activity
Pages
Attachments

Page templates
Apps Scripts

Deleted items

General

Sharing and
Permissions

LT

Maps Play YouTube I Gmail Drive Calendar More ~

Search my sites

SAVE Preview Cancel

Select a theme to use or build your own custom theme

1=

lceberg Q_ Open Sky Q Rounders Q, Slate Q
e
——
| |
Legal Pad @ Blank Slate Q Micro Blueprint Q Micro Lite @

Simple Q

ET—
Micro Sport Q

d. After you have saved your theme selection, click your site name under Manage Site.
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+John 5 N Mlaps Play YouTube Gmail Drive

Calendar More

GOUgle Search my sites “

Manage Site SAVE Preview

Cancel

< Wiki Example C1LA Select a theme to use or build your own custom theme

Recent site activity
Pages —
Attachments )

Page templates

lceberg Q Open Sky Q Rounders Q, Slate Q Simple Q
Apps Scripts
Deleted items e — S
Gereral d v 1 T T
o
Sharing and
Permissions I ] ETEE—
P Legal Pad Qo Blank Slate Q Micro Blueprint @ Micro Lite Q Micro Sport Q

Step 5: Update the Home page.

a. The Home page is the first page that everyone sees when they come to your wiki site. You can edit the

content of this page by clicking the edit button. From here, you can add text, pictures, or anything else to
show on this page.

HOME. Lyt i wm

Home
Sitemap HDme

b. Click Save after you make your changes. This takes you out of page edit mode.

John Smith ~
Home —1 -
Insert Format Table Layout

2l Normal - | 10pt -B r u A- B |ceo|}

ks =S EEE EIEE| &K am
— Home
itemap
Welcomb to our Wiki Site!
Please feel fre o to the Wiki pages on the left and enter content

Step 6: Create a wiki page.

a. To create a new page that you and your visitors can use to make posts, click the new page icon.
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Home Updated 2 minutes ago

earsmey | 4 (B Dere -
Home
Sitemap

Home

Welcome to our Wiki Site!

Please feel free to go to the Wiki pages on the left and enter content.

b. Inthe Name your page field, enter a page name. In the example below, the name Routers is used as the
topic for this page.
Sites Cancel
Create a page in Site: Wiki Example C1LA
ame your page:
| Routers
gellll sitaiwikieyamaleetaiters change URL
C.

Click the Web Page drop-down menu and select Announcements. Google uses this term to indicate a
wiki page.

Create a page in Site: Wiki Example C1LA

MName your page:

Routers
Your page URL: /site/wikiexamplec1la/routers change URL

Select a template to use (Learn mare)

Web Page

(Annnuncements >

File 30mer

List
" Put page under Home

d. Click CREATE to create your new wiki page.
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Sites @ancel

Create a page in Site: Wiki Example C1LA

MName your page:
Routers

Your page URL: /site/wikiexamplec1la/routers change URL

Select a template to use (Learn more)

|Ennouncements = |

Qalart a laratinn-

e. Your new wiki page, called Routers, displays and has a New post menu option that allows information to
be added to the page. (Notice that the left sidebar has a new link to allow your site visitors access to this

page.)

John Smith +

Routers

[+

Take our survey! r'd

Routers

There are currently no posts. Create one now by clicking the "New post” button.

Sitemap

[&) Subscribe to posts

Step 7: Share your web site.
A wiki site is not really a wiki site unless other people can contribute. There are a number of ways to share
your new site. In this example, we will show you how to share your site to designated people who have Gmail
accounts.

a. On your wiki site, click Share.

John Smith +

Take our survey! F 4 More ~

Routers

Home
Routers
Sitemap

Routers

Hew post B Subscribe to posts

There are currently no posts. Create one now by clicking the "New post” button.

b. Add a name, email address, or group who you grant access to this site.



1.1.1.8 Lab — Researching Network Collaboration Tools 15

Who has access

Public on the web - Anyone on the Intgrmet
S can find and view f@ Change...
3 John Smith {(you) jsmith.netacad@gmail.com ls owner

d people:
Enter names, email addresses, or groups...

c. As soon as you start entering information into the Add people box, the box provides more options. The
Can edit drop-down menu allows you to choose the document privileges (Can edit, Can comment, Can
view) for the people you add. You can also specify how to notify these people of this document (Send a
copy to myself or Paste the item itself into the email). Click Share & save.

Add people:  Choose from contacts
‘ janedoe@gmail.com| ‘
+ Motify people via email - Add message

Cancel Send a copy to myself

d. Click Share & save to save your sharing settings.

Add people:  Choose from contacts

janedoe@gmail .com| Can edit -

fp=pagple via email - Add message

Cancel Send a copy to myself

Share & save

e. The Manage Site page displays the people who have access to your site. Click your site name to return
to your home page.
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Manage Site Enable page-level permissions

[ Wiki Example C1LA Link to share
| https://sites._go

Recent site activity

Pages Share link via .M. g n

Attachments

Who has access
Page templates %
Public on the web - Anyone on the Internet

Apps Scripts & can find and view Change...
Deleted items

2 John Smith (you) jsmith.netacad@gmail.com Is owner
General
Sharing and = Jane Doe janedoe@agmail.com Can edit = ®
Permissions
AdSense

Step 8: Provide the URL of your site.

You can provide your URL to your new site by adding your site name to the end of the Google site URL, as
shown here: http://sites.google.com/site/(sitename).

Step 9: Find additional information.
You can find a quick overview of how a wiki works at http://www.youtube.com/watch?v=-dnLO0TdmLY.

Other examples of wikis and their web sites include:

o  Wikipedia — http://www.wikipedia.org/
e Atlassian Confluence (a popular business wiki) — http://www.atlassian.com/software/confluence/

e Wikispaces (another free wiki) — http://www.wikispaces.com/

Reflection

1. Can you think of other collaboration tools used in the business world today?

2. What collaboration tools do you see as useful to a network administrator?
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1.2.3.3 Lab — Researching Converged Network Services

Objectives
Part 1: Survey Your Understanding of Convergence
Part 2: Research ISPs Offering Converged Services
Part 3: Research Local ISPs Offering Converged Services
Part 4: Select Best Local ISP Converged Service

Part 5: Research Local Company or Public Institution Using Convergence Technologies

Background / Scenario

Convergence in the context of networking is a term used to describe the process of combining voice, video,
and data communications over a common network infrastructure. Converged networks have existed for some
time, but were only feasible in large enterprise organizations because of the network infrastructure require-
ments and complex management required to make them work seamlessly. Technology advances have made
convergence readily available to large, medium, and small businesses, as well as for the home consumer.

In Part 1, you will describe your current understanding of convergence and any experience you have with it.

In Part 2, you will research which providers have this service, regardless of geographical location, using the
predefined form included in the lab.

In Part 3, you will research which local ISPs in your area offer converged services for end-user consumers,
using the predefined form included in the lab.

In Part 4, you will select the ISP you like best for home use and list the reasons why.

In Part 5, you will find a local company or public institution using convergence technologies in their business,
using the predefined form included in the lab.

Required Resources
Device with Internet access

Part 1: Survey Your Understanding on Convergence

Step 1: Describe convergence as you understand it and give examples of its use in the home.

Write a definition of convergence and list some examples.
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Part 2: Research ISPs Offering Converged Services

In Part 2, you research and find two or three ISPs who offer converged services for the home, regardless of
geographical location.

Step 1: Research various ISPs that offer converged services.

List some of the ISPs that you found in your search.

Step 2: Fill in the following form for the ISPs selected.

Internet Service Provider Product Name of Converged Service

Part 3: Researching Local ISPs Offering Converged Services

In Part 3, you research and find two or three local ISPs who offer converged services for the home in your
geographic area.

Step 1: Research various ISPs that offer converged services.

List some of the ISPs that you found in your search.

Step 2: Fill in the following form for the ISPs selected.

Product Name of Converged
Internet Service Provider Service Cost per Month Download Speed

Part 4: Select Best Local ISP Converged Service Offering

Select your top choice from the list of local ISPs that you selected and give reasons why you chose that par-
ticular one.
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Part 5: Research Local Company or Public Institution Using Convergence

Technologies

In Part 5, you research and locate a company in your area that currently uses convergence technologies in

their business.

Step 1: Research and find a local company using convergence.

In the following table, list the company, industry, and convergence technologies used.

Name of Company

Industry

Convergence Technologies

Reflection

1. What are some of the advantages of using convergence technologies?

2. What are some of the disadvantages of using convergence technologies?
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1.3.1.3 Lab — Mapping the Internet

Objectives
Part 1: Test Network Connectivity Using Ping
Part 2: Trace a Route to a Remote Server Using Windows Tracert
Part 3: Trace a Route to a Remote Server Using Web-Based and Software Tools

Part 4: Compare Traceroute Results

Background

Route tracing computer software is a utility that lists the networks data has to traverse from the user’s origi-
nating end device to a distant destination network.

This network tool is typically executed at the command line as:
tracert <destination network name or end device address>
(Microsoft Windows systems)

or
traceroute <destination network name or end device address>
(Unix and similar systems)

Route tracing utilities allow a user to determine the path or routes as well as the delay across an IP network.
Several tools exist to perform this function.

The traceroute (or tracert) tool is often used for network troubleshooting. By showing a list of routers tra-
versed, it allows the user to identify the path taken to reach a particular destination on the network or across
internetworks. Each router represents a point where one network connects to another network and through
which the data packet was forwarded. The number of routers is known as the number of “hops” the data trav-
eled from source to destination.

The displayed list can help identify data flow problems when trying to access a service such as a website. It
can also be useful when performing tasks such as downloading data. If there are multiple websites (mirrors)
available for the same data file, one can trace each mirror to get a good idea of which mirror would be the
fastest to use.

Two trace routes between the same source and destination conducted some time apart may produce different
results. This is due to the “meshed” nature of the interconnected networks that comprise the Internet and the
Internet Protocols ability to select different pathways over which to send packets.

Command-line-based route tracing tools are usually embedded with the operating system of the end device.

Other tools, such as VisualRoute™, are proprietary programs that provide extra information. VisualRoute
uses available online information to graphically display the route.

This lab assumes the installation of VisualRoute. If the computer you are using does not have VisualRoute
installed, you can download the program using the following link:

http://www.visualroute.com/download.html
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If you have any trouble downloading or installing VisualRoute, ask your instructor for assistance. Ensure that
you download the Lite Edition.

Windows XP\2003\vista\7 4,0Mb Download
bl L S Mac 05 X (dmg) 10.3+, universal

bi 2.0Mb Download
inary

Scenario

Using an Internet connection, you will use three route tracing utilities to examine the Internet pathway to
destination networks. This activity should be performed on a computer that has Internet access and access to
the command line. First, you will use the Windows embedded tracert utility. Second, you will use a web-based
traceroute tool (http://www.subnetonline.com/pages/network-tools/online-traceroute.php). Finally, you will use
the VisualRoute traceroute program.

Required Resources

1 PC (Windows 7, Vista, or XP with Internet access)

Part 1. Test Network Connectivity Using Ping

Step 1: Determine whether the remote server is reachable.
To trace the route to a distant network, the PC used must have a working connection to the Internet.

a. The first tool we will use is ping. Ping is a tool used to test whether a host is reachable. Packets of infor-
mation are sent to the remote host with instructions to reply. Your local PC measures whether a response
is received to each packet, and how long it takes for those packets to cross the network. The name ping
comes from active sonar technology in which a pulse of sound is sent underwater and bounced off of ter-
rain or other ships.

b. From your PC, click the Windows Start icon, type cmd in the Search programs and files box, and then
press Enter.

S @ & - O

c. Atthe command-line prompt, type ping www.cisco.com.
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C:\>ping WWwWw.cisco.com

Pinging el44.dscb.akamaiedge.net [23.1.48.170] with 32 bytes of data:
23.1.48.170: bytes=32 time=56ms TTL=57
23.1.48.170: bytes=32 time=55ms TTL=57
23.1.48.170: bytes=32 time=54ms TTL=57
23.1.48.170: bytes=32 time=54ms TTL=57

Ping statistics for 23.1.48.170:

Packets: Sent = 4, Received = 4, Lost = 0 (8% loss),
Approximate round trip times in milli-seconds:

Minimum = S4ms, Maximum = 58ms, Average = Sims

The first output line displays the Fully Qualified Domain Name (FQDN) e144.dscb.akamaiedge.net.
This is followed by the IP address 23.1.48.170. Cisco hosts the same web content on different servers
throughout the world (known as mirrors). Therefore, depending upon where you are geographically, the
FQDN and the IP address will be different.

From this portion of the output:

Ping statistics for 23.1.48.170:
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milli-seconds:
Minimum = S4ms, Maximum = S6ms, Average = Sims

Four pings were sent and a reply was received from each ping. Because each ping was responded to,
there was 0% packet loss. On average, it took 54 ms (54 milliseconds) for the packets to cross the net-
work. A millisecond is 1/1,000" of a second.

Streaming video and online games are two applications that suffer when there is packet loss, or a slow
network connection. A more accurate determination of an Internet connection speed can be determined
by sending 100 pings, instead of the default 4. Here is how to do that:

C:\>ping -n 100 www.cisco.com

And here is what the output from that looks like:

Ping statistics for 23.45.0.170:
Packets: Sent = 100, Received = 100, Lost = 0 (0% loss),

Approximate round trip times in milli-seconds:
Minimum = Y46ms, Maximum = 53ms, Average = 49ms

Now ping Regional Internet Registry (RIR) websites located in different parts of the world:

For Africa:

C:\> ping www.afrinic.net
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C:\>ping www.afrinic.net

Pinging wuww.afrinic.net [196.216.2.136] with 32 bytes of data:

196.216.2.136:
196.216.2.1386:
196.216.2.1386:
196.216.2.136:

bytes=32 time=314ms
bytes=32 time=312ms
bytes=32 time=313ms
bytes=32 time=313ms

Ping statistics for 196.216.2.136:

Packets: Sent =

Minimum = 312ms,

For Australia:

C:\> ping www.apnic.net

C:\>ping wuwwW.apnic.net

4. Received -
Approximate round trip times in milli-seconds:
Maximum =

4, Lost = O

314ms, Average

Pinging www.apnic.net [202.12.29.194] with 32

Reply from 202.12.29.194:
Reply from 202.12.29.194:
Reply from 202.12.29.194:
Reply from 202.12.29.194:

bytes=32 time=286ms
bytes=32 time=28Tms
bytes=32 time=286ms
bytes=32 time=286ms

TTL=111
TTL=111
TTL=111
TTL=111

(0% loss),

= 313ms

bytes of data:
TTL=439
TTL=49
TTL=49
TTL=49

Ping statistics for 202.12.29.194:
Packets: Sent = 4, Received = 4, Lost = @
Approximate round trip times in milli-seconds:
Minimum = 286ms, Maximum = 287Tms, Average =

(0% loss),

28Bms

For Europe:

C:\> ping www.ripe.net

C:\>ping wwW.ripe.net

Pinging wwwW.ripe.net [193.0.6.139] with 32 bytes of data:
timed out.

timed
timed
timed

out.
out.
out.

Ping statistics for 193.0.6.139:

Packets: Sent = 4, Received = 8, Lost = 4 (100% loss),

For South America:

C:\> ping lacnic.net
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C:\>plhg wWwwW.lacnic.net

Pinging www.lacnic.net [200.3.14.147] with 32 bytes of data:

Reply from 200.3.14.147:
Reply from 200.3.14.147;
Reply from 200.3.14.147:
Reply from 200.3.14.147:

Ping statistics for 200

bytes=32 time=158ms TTL=51
bytes=32 time=158ms TTL=51
bytes=32 time=158ms TTL=51
bytes=32 time=157ms TTL=51

L3LTH14T:

Packets: Sent = 4, Received = 4, Lost = 0 (8% loss),
Approximate round trip times in milli-seconds:
Minimum = 157ms, Maximum = 158ms, Average = 157ms

All these pings were run from a computer located in the U.S. What happens to the average ping time in
milliseconds when data is traveling within the same continent (North America) as compared to data from
North America traveling to different continents?

What is interesting about the pings that were sent to the European website?

Part 2: Trace a Route to a Remote Server Using Tracert

Step 1: Determine what route

across the Internet traffic takes to the remote server.

Now that basic reachability has been verified by using the ping tool, it is helpful to look more closely at each
network segment that is crossed. To do this, the tracert tool will be used.

a. Atthe command-line prompt, type tracert www.cisco.com.

C:\>tracert uww.cisco.com

Tracing route to el144.dscb.akamaiedge.net [23.1.144.170]
over a maximum of 30 hops:

<1 ms <1 ms
38 ms 38 ms
37 ms

43 ms
42 ms
45 ms
48 ms

45 ms
1.144.170]

Trace complete.

<1 dslrouter.uwestell.com [192.168.1.1]
37 10.18.20.1
37 G3-0-9-2204.ALBYNY-LCR-02 .verizon-gni.net [130.8

42 $0-5-1-1-0.NY¥325-BB-RTR2.verizon-gni.net [130.81
65 0.s50-4-0-2 . XT2.NYC4.ALTER.NET [152.63.1.57]

45 0.50-3-2-0.XL4 .EWRG.ALTER.NET [152.83.17.109]
46 TenGigE@-5-0-0.GWS .EWRG.ALTER.NET [152.63.21.14]

45 a23-1-144-170.deploy.akamaitechnologies.com [23.

b. Save the tracert output in a text file as follows:
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Right-click the title bar of the Command Prompt window and choose Edit > Select All.

Right-click the title bar of the Command Prompt window again and choose Edit > Copy.

Open the Windows Notepad program: Windows Start icon > All Programs > Accessories > Notepad.
To paste the output into Notepad, choose Edit > Paste.

Choose File > Save As and save the Notepad file to your desktop as tracert1.txt.

Run tracert for each destination website and save the output in sequentially numbered files.

C:\> tracert www.afrinic.net

C:\> tracert www.lacnic.net

Interpreting tracert outputs.

Routes traced can go through many hops and a number of different Internet Service Providers (ISPs),
depending on the size of your ISP and the location of the source and destination hosts. Each “hop” repre-
sents a router. A router is a specialized type of computer used to direct traffic across the Internet. Imagine
taking an automobile trip across several countries using many highways. At different points in the trip you
come to a fork in the road in which you have the option to select from several different highways. Now
further imagine that there is a device at each fork in the road that directs you to take the correct highway
to your final destination. That is what a router does for packets on a network.

Because computers talk in numbers, rather than words, routers are uniquely identified using IP addresses
(numbers with the format x.x.x.x). The tracert tool shows you what path through the network a packet of
information takes to reach its final destination. The tracert tool also gives you an idea of how fast traffic is
going on each segment of the network. Three packets are sent to each router in the path, and the return
time is measured in milliseconds. Now use this information to analyze the tracert results to www.cisco.
com. Below is the entire traceroute:

C:\>tracert uww.cisco.com

Tracing route to el144.dscb.akamaiedge.net [23.1.144.170]
over a maximum of 30 hops:

1 <1 ms <1 ms <1 dslrouter.uwestell.com [192.168.1.1]

p 38 ms 38 ms 37 10.18.20.1

3 37 ms 37 ms 3 G3-0-9-2204.ALBYNY-LCR-02 .verizon-gni.net [130.8
1.196.190]
4 43 ms 43 ms 42 $0-5-1-1-0.NY¥325-BB-RTR2.verizon-gni.net [130.81
2
5
6
T

.22.46]
43 ms 43 ms 65 0.s0-4-0-2.XT2.NYC4.ALTER.NET [152.63.1.57]
45 ms 45 ms 45 0.s0-3-2-0.XL4.EWRG.ALTER.NET [152.63.17.109]
46 ms 48 ms 46 TenGigE@-5-0-0.GUWS.EWRE .ALTER.NET [152.63.21.14]

8 45 ms 45 ms 45 a23-1-144-170.deploy.akamaitechnologies.com [23.
1.144.170]

Trace complete.

Below is the breakdown:
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Each arrow points to a packet that took less Router on the computer
than 1 millisecond to access the first router. home network
1 <1 ms <1 ms <1 ms dslrouter.uwestell.com [192.168.1.1]

2 38 ms 38 ms 3T ms 10.18.20.1

LN

|Hop 2 POP router]

In the example output shown above, the tracert packets travel from the source PC to the local router de-
fault gateway (hop 1: 192.168.1.1) to the ISPs Point of Presence (POP) router (hop 2: 10.18.20.1). Every
ISP has numerous POP routers. These POP routers are at the edge of the ISP’s network and are the
means by which customers connect to the Internet. The packets travel along the Verizon network for two
hops and then jump to a router that belongs to alter.net. This could mean that the packets have traveled
to another ISP. This is significant because sometimes there is packet loss in the transition between ISPs,
or sometimes one ISP is slower than another. How could we determine if alter.net is another ISP or the
same ISP?

There is an Internet tool known as whois. The whois tool allows us to determine who owns a domain
name. A web-based whois tool is found at http://whois.domaintools.com/. This domain is also owned by
Verizon according to the web-based whois tool.

Registrant:
Verizon Business Global LLC
Verizon Business Global LLIC
One Verizon Way
Basking Ridge NJ 07920
us
domainlegalcontact@verizon.com +1.7033513164 Fax: +1.7033513669

Domain Name: alter.net

To summarize, Internet traffic starts at a home PC and travels through the home router (hop 1). It then
connects to the ISP and travels through its network (hops 2-7) until it arrives at the remote server (hop 8).
This is a relatively unusual example in which there is only one ISP involved from start to finish. It is typical
to have two or more ISP involved as displayed in the following examples.

Now examine an example that involves Internet traffic crossing multiple ISPs. Below is the tracert for
www.afrinic.net:
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C:\>tracert www.afrinic.net

Tracing route to www.afrinic.net [196.216.2.136]
over a maximum of 30 hops:

1 ms <1 ms <1 dslrouter.westell.com [192.168.1.1]
39 ms 38 ms 37 10.18.20.1
40 ms 38 ms 39 G4-0-0-2204 . ALBYNY-LCR-02 .verizon-gni.net [130.8
97.182]
44 ms 43 ms 43 $0-5-1-1-0.NY325-BB-RTR2.verizon-gni.net [130.81

1.

=
[+1]
[

43 ms 43 ms 42 0.50-4-0-0.XT2.NYC4.ALTER.NET [152.63.9.249]
43 ms ™1 ms 43 0.ae4.BR3.NYCH.ALTER.NET [152.63.16.185]
47 ms 47 ms 47 te-7-3-0.edge2.NewYorkz.level3 . net [4.68.111.137

SO UANE =W =

43 ms 55 ms 43 vlanS51.ebr1 . NewYork2.Level3.net [4.69.138.222]
52 ms 51 ms 51 ae-3-3.ebr2 . lWashingtonl .Level3 . net [4.69.132.89]

130 ms ms ae-42-42 ebr2 Parisl.Level3.net [4.69.137.53]
139 ms ms ae-46-46 .ebrl1 . Frankfurtl.Level3 . net [4.69.143.13

148 ms ms ae-91-91 .cswd .Frankfurtl.Level3.net [4.69.140.14
144 ms ms ae-92-92 . ebr2 .Frankfurtl.Level3.net [4.69.140.29
151 ms ms ae-23-23.ebr2.Londonl .Level3 . net [4.69.148.193]
150 ms ms ae-58-223.csuw2.Londonl .Level3 . net [4.69.153.138]
156 ms ms ae-227-3603.edge3.Londonl .Level3 . net [4.69.166.1
157 ms ms 195.50.124 .34

353 ms ms 168.209.201.74

333 ms ms cswi-pkl-gil-1.ip.isnet.net [196.26.0.101]

331 ms ms 196.37.155.180

318 ms ms fal-0-1.ar02. jnb.afrinic.net [196.216.3.132]
332 ms ms 196.216.2.136

Trace complete.

What happens at hop 77 Is level3.net the same ISP as hops 2-6, or a different ISP? Use the whois tool to
answer this question.

What happens in hop 10 to the amount of time it takes for a packet to travel between Washington D.C.
and Paris, as compared with the earlier hops 1-9?

What happens in hop 18? Do a whois lookup on 168.209.201.74 using the whois tool. Who owns this
network?
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g. Type tracert www.lachic.net.

C:\>tracert www.lacnic.net

Tracing route to www.lacnic. [200.3.14.147]
over a maximum of 30 hops:

<1 ms <1 ms <1 dslrouter.westell.com [192.168.1.1]

38 ms 38 ms 37 10.18.20.1

38 ms 38 ms 39 G3-0-9-2204 .ALBYNY-LCR-02.verizon-gni.net [130.8
96.190]

42 ms 43 ms 42 s0-5-1-1-0.NY¥325-BB-RTR2.verizon-gni.net [130.81

1.

82 ms 47 ms 47 0.ae2 . BR3.NYC4.ALTER.NET [152.63.16.49]

46 ms 47 ms 56 204.255.168.194

157 ms ms ge-1-1-0.100.gul .gc.registro.br [159.63.48.38]
156 ms ms xe-5-0-1-0.corel.gc.registro.br [200.160.0.174]

1
2
3
1
y
.22.46]
5
3
7
8

161 ms ms Xe-4-0-0-0.core2.nu.registro.br [200.160.0.164]

158 nms ms ae@-0.ar3.nu.registro.br [200.160.0.249]
176 ms ms gwB2.lacnic.registro.br [200.160.08.213]
158 ms 200.3.12.36

ms 200.3.14.147

What happens in hop 77?

Part 3: Trace a Route to a Remote Server Using Web-Based and Software-
Tools

Step 1: Use a web-based traceroute tool.

a. Using http://www.subnetonline.com/pages/network-tools/online-tracepath.php to trace the route to the fol-
lowing websites:

WWW.CiSco.com
www.afrinic.net

Capture and save the output in Notepad.

How is the traceroute different when going to www.cisco.com from the command prompt (see Part 1)
rather than from the online website? (Your results may vary depending upon where you are located geo-
graphically, and which ISP is providing connectivity to your school.)
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Compare the tracert from Part 1 that goes to Africa with the tracert that goes to Africa from the web inter-
face. What difference do you notice?

Some of the traceroutes have the abbreviation asymm in them. Any guesses as to what this means?
What is its significance?

Step 2: Use VisualRoute Lite Edition
VisualRoute is a proprietary traceroute program that can display the tracing path results graphically.
a. Please download the VisualRoute Lite Edition from the following link if it is not already installed:

http://www.visualroute.com/download.html

If you have any trouble downloading or installing VisualRoute, ask your instructor for assistance. Ensure
that you download the Lite Edition.

b. Using VisualRoute 2010 Lite Edition, trace the routes to www.cisco.com.

c. Record the IP addresses in the path in Notepad.

@ VisualRoute 2010 - Lite Edition | =G

File Edit Options Maps Tools Help
[Test to AP v| = trace |
|@Start Views: O E A © G ‘
(= Traceroute to www.cisco.co BEI
Target Information - Route Information
To ) W-C?SCO-CDH" (23.1.144.170) « Analysis In general this route offers a good throughput,
Location Cambridge, MA, USA EI with hops responding on average within 39ms. E
Network Mot available in free edition RTT 42 9ms | 97ms
RTT 53.0ms / 50ms / 5Tms -
f_"‘i_"“”_"l':“ R —— - Packet Loss 0.0% /0% >,
«/“Traceroute to www.cisco.com o8
RTT ms
ag
80
70
= 152.63:17.109 @
e — e e R 3 EE—
152.53.9.24_9'_'_,__4?—— 1 gy
e fE
2 13081 1511] 13081 22458
a0 [1048:201] [130.81.196.188] .- OG5
R e
30 -
20
10

192.1681 17 [192.1681 1
o o
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Part 4: Compare Traceroute Results

Compare the traceroute results to www.cisco.com from Parts 2 and 3.

Step 1: List the path to www.cisco.com using tracert.

Step 2: List the path to www.cisco.com using the web-based tool on subnetonline.com.

Step 3: List the path to www.cisco.com using VisualRoute Lite edition.

Did all the traceroute utilities use the same paths to www.cisco.com? Why or Why not?

Reflection

Having now viewed traceroute through three different tools (tracert, web interface, and VisualRoute), are there
any insights that using VisualRoute provided that the other two tools did not?
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1.4.4.3 Lab — Researching IT and Networking Job Opportunities

Objectives

Part 1: Research Job Opportunities

e Identify the current networking jobs that are in demand.

e Explain the value of Cisco certifications in the job market.
Part 2: Reflect on Research

e Identify current hiring trends in IT/networking.
o |dentify future networking career certifications and skills.
e |dentify additional networking career paths.

Background / Scenario
Jobs in Information Technology (IT) and computer networking continue to grow. Most employers require some
form of industry standard certification, degree, or other qualifications from their potential employees, especial-
ly those with limited experience. The Cisco CCNA certification is a known and established entry level network-
ing certification that is respected in the industry. There are additional levels and kinds of Cisco certifications
that one can attain, and each certification may enhance employment opportunities as well as salary range.
In this lab, you will do some targeted job searching on the web, to find what types of IT and computer net-

working jobs are available; what kinds of skills and certifications you will need; and the salary ranges associ-
ated with the various job titles.

Required Resources

e Device with Internet access

Part 1: Research Job Opportunities

In Part 1, you will use a web browser to visit the popular job listing web sites monster.com and salary.com.

Step 1: Open a web browser and go to a job listing website.
In the URL address bar type in http://monster.com and press Enter.
Note: For job listings outside of the US, use the following link to search for your country:

http://www.monster.com/geo/siteselection/

Step 2: Search for networking related jobs.

a. Type the word Network in the Job title box. Notice that the website offers context sensitive suggestions
based on the keywords provided. Either click on, or finish typing the words, Network Administrator and
click the SEARCH button (see image below).
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Build a Better Career. Find Your Calling. | Monster.com - Mozilla Firefioo

Vew  Hgtory Bockmaris Tools Hep
Buid a Better Career, Find Your €| =

[ e v mnster.com

Home  HResume Jobs CareerTools Advice Communities

monster

g for... in US...

L3

Browse Jobs by Company, Location of Categories & Industries

b. Notice the search results:

Home Resume Jobs Career Tools Advice Communities

maons te r Network Administrator Any Skills or Keywords in

Empiowery

Sqeer ey Find your
f  Signin with facebook E it e Rt

358 Network Administrator jobs matched your search

3

Advanced Search Sort by relevance =

Sel
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C.

T Network Administrator Jobs

e > Iﬂmeudn.mwmmmﬁumwk-h&mb'a:m_s

Now focus your search by adding terms to the keywords field box. Try terms like Cisco CCNA, CCNP,

Sr. Network Systems Administrator - LANMWAN
systems, Saas, Junip

CyberCoders - $80,000 - $110,000

Today

LAN Administrator - TCPIP, VPN, Network Security
CyberCoders + $40,000 - $50.000
Today

Network Administrator - Windows, Linux, Cisco,
Exchange, VMWare

CyberCoders - $75.000 - 550,000

Today

Retail Manager
Love’s Travel Stops & Country St...

Featured Job

Earn The Degree That's Right For Youl

Advance your career by going back to school. Find out what
administrative program is best for you.

Featured Opportunity

Network Administrator - Windows environment -
Start-up Company

CyberCoders - 570,000 - $85,000

Today

Manhattan, WY

Appleton, Wi

Philadelphia, PA

Wamsutter, W'

Campus or Onlna

Programs

Wiakham, L&

Texas - Network Administrator - Telecom Administrator Sefmead T

CyberCoders - 560,000 - 5100.000

CCNA Security, CCNA Voice, etc.

Now try refining your search by adding in different geographical locations. Did you find jobs in the loca-

tions you entered?

S5
Ses who you
kmow

101
=
Ses who you
know

288
See who you
kmiower

288
Ses who you
knowy

@o
.-EL-‘ B

Ses who you
ki

Try searching a different website. Go to http://salary.com and click the Job Search menu bar button.

Note: For salary listings outside of the US, use the following link to search for your country:

http://www.payscale.com/rccountries.aspx
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") welcome to Salary.com - Salary.com - Mozilla Firefox
£} Wekcaens to Salary.com - Salary.com |m I
€ < I&sden.m 7 G]E

3 Online Training Courses 6,000+ Courses to Choose From. Fres "Getting Started” Whitepaper. s Siiliet com
" Web Developer Courses Become a Web Developer. Free Info on Web Development Courses Onling, wow vy
% UMLUC Cvbersecurity Degree Get 2 BS/MS in Cybersecurity from a global online university. swe i psso

Foll

I ® Search & Salaries © Jobs rowse Salar ¢
su ﬂl'y@om :

Enter & job fifle Enfer a cily or posial code a gir

you're more than just a salary

Job Search | Education Career Development Work & Life

Welcome to Salary.com

Whatwe can eam and how we earm it plays a gominant role in our Ives. Itis a measure of where we are in our
Careers—our sutcassas and our struggles. But more importanty, the maney we aarm helps us live the life we seek
Salary.com is devoled to delivering accurate and credible salary calculations and salan-related atvice. But we also

nadarsiand that vaor calar and aamina natantial amasuwars v b maka rhealal life Aadeiane_lika nisdnn 5

f. Now add a search term like Information Technology to the job title field box and click Submit.

J @ salary.comjcategory fjob-search/

I ® Search * Salaries ¢ Jobs 8
salary.om

Enter a job title Enter a cify or postal code

you're more than just a salary

Salary Job Search | Education Career Development m
Job Search
Eike |15 W Tweet ¢_1i_ g+)s m share| (] Email 3, Print

Search Job Openings Search Job Openings

Job Title:
Job Evaluation Tool ||nformation Technology]

Location:
Job Alert Emails I |En.rera city or postal code
Submit J
Browse Job Openings

g. Inthe image below, note the large number of matching search results. There are also easy to use tools
for refining your search, in the column to the left.
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'Job Search Wizard Save this search

FIND A JOB |InformatiunTed1noEogv IN |c.-r,f state or Zip m
r o L: . —— |
AL [nformation Technology

Minimum Salary
40

€$30,000
€$50,000
©475,000
$100,000
©4150,000
€%$200,000

Job Type

Crull Time
CPart Time

C Contract
CTemporary
Cinternship
©all job types

Jobs Published

®anyTime
Cwithin 15 days
Cwithin 7 days
[l VE S R .

Ads by Google

IT Consulting Senvices
NET & SQL-Microsoft Cerified 100s Of Successtul Client Projects
www.amadeusconsulting.com/

Infrastructure Monitoring
System Health, Log Files & Uptime Free trial with excellent support
www. eventsentry. com/FreeEval

Server Health Event Log

Compliance Downloads

Log Files Metwork Monitoring

ij2|3l4al5|6|7]18] [ Jobs 1 to 10 of 200678 matches

IT Infrastructure and Operations Specialist
Ghirardelli Chocolate - San Leandro, CA

of the following technologies: MS Operating Systems... and interast to learn new IT
skills and new technologies Teamwaork (within IT and outside the IT team...
Ghirardelli Chocolate - 88 Days ago  save

Technical Program/Delivery Manager
Garrigan Lyman Group - Seattle, WA

chient and the GLG user experience, creative, and technology roles, Working
collaboratively with the user... sensitive information tactfully s Understands how to...
Indeed - 21 Days ago  save

h. Spend some time searching for jobs and looking through the search results. Take note of what skills are
required for different job titles and the range of starting salaries.

Part 2: Reflect on Research

In Part 2, you answer questions based on your research findings.

a.

What job titles did you search for?

What skills or certifications were required?

Did you find any jobs that you previously did not know existed? If so, what were they?

Did you find any jobs that you are interested in? If so, which ones and what skills or certifications do they

require?
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1.5.1.1 Class Activity — Draw Your Concept of the Internet Now

Objectives

Identify the common components of a network.

e Students will illustrate how concepts from Chapter 1 are applied to show how network devices connect
to and throughout the Internet. After reflecting on their home or small-business topology, students will
become familiar with using the device icons and knowledge needed to visualize network connectivity
through the remaining network courses.

Background / Scenario

In this activity, you will use the knowledge you have acquired throughout Chapter 1, and the modeling activity
document that you prepared at the beginning of this chapter. You may also refer to the other activities com-
pleted in this chapter, including Packet Tracer activities.

Draw a map of the Internet as you see it now. Use the icons presented in the chapter for media, end devices,
and intermediary devices.

In your revised drawing, you may wish to include some of the following:

*  WANSs

* LANs

»  Cloud computing

» Internet Service Providers (tiers)

Save your drawing in hard-copy format. If it is an electronic document, save it to a server location provided by
your instructor. Be prepared to share and explain your revised work in class.

Required Resources
e Beginning of chapter modeling activity drawing

e Packet Tracer (may be optional if students sketch their own drawing)

e Paper and pencils or pens

Reflection

1. After completing Chapter 1, are you more aware of the devices, cabling, and physical components of a small-
to-medium size network? Explain your answer.

Modeling Activity Graphic Representation (designs will vary)
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